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1. Vigtigt
Denne elektroniske brugervejledning er beregnet 
til alle, der bruger Philips-skærmen. Tag den tid du 
behøver for at læse vejledningen, inden du bruger 
skærmen. Den indeholder vigtige oplysninger om 
bemærkninger angående brugen af din skærm.

Philips garanti dækker under forudsætning af, at 
produktet behandles korrekt og anvendes til det 
tilsigtede formål i overensstemmelse med dens 
betjeningsvejledning, og ved forevisning af den 
originale faktura eller kvittering med angivelse af 
købsdatoen, forhandlerens navn samt model og 
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og vedligeholdelse

Advarsler
Anvendelse af kontrolelementer, justeringer eller 
fremgangsmåder, der ikke er beskrevet i denne 
dokumentation, kan resultere i elektrisk stød, 
elektriske ulykker og/eller mekaniske ulykker.
Læs og følg disse vejledninger, når du tilslutter og 
anvender din computerskærm:

Betjening:
Hold skærmen væk fra direkte sollys og væk 
fra brændeovne og andre varmekilder.
Fjern alt, der kan risikere at falde i 
ventilationshullerne eller forhindre korrekt 
afkøling af skærmens elektronik. 
Bloker ikke ventilationshullerne på kabinettet.
Ved placering af skærmen skal du sikre dig, 
at det er let at komme til strømstikket og 
stikkontakten.
Hvis der slukkes for skærmen ved at fjerne 
strømkablet eller jævnstrømsledningen, skal du 
vente 6 sekunder, før du sætter strømkablet 
eller jævnstrømsledningen til igen for at opnå 
normal betjening.

Brug altid et godkendt strømkabel, der 
er leveret af Philips. Hvis du mangler dit 
strømkabel, skal du kontakte dit lokale 
servicecenter. (Se Informationscenter for 
kundepleje)
Udsæt ikke skærmen for kraftige vibrationer 
eller stød under anvendelse.
Slå ikke på skærmen, og tab den ikke under 
brug eller transport.

Vedligeholdelse:
Som en beskyttelse af skærmen skal du undgå 
at trykke kraftigt på LCD-panelet. Når du 
flytter din skærm, så tag fat om rammen for at 
løfte den; løft ikke skærmen ved at sætte din 
hånd eller fingre på LCD-skærmen.
Tag stikket ud fra skærmen, hvis du ikke skal 
bruge den i en længere periode.
Tag stikket ud at kontakten til skærmen, hvis 
du skal rengøre den med en let fugtet klud. 
Skærmen kan tørres af med en tør klud, 
når der er slukket for strømmen. Under alle 
omstændigheder, må der ikke bruges organiske 
opløsningsmidler til rengøring af din skærm.
For at undgå risiko for elektrisk stød eller 
permant beskadigelse af anlægget, så må du 
ikke udsætte skærmen for støv, regn, vand eller 
miljøer med høj fugtighed.
Hvis din skæm bliver våd, skal den tørres af 
med en tør klud så hurtigt som muligt. 
Hvis der kommer fremmed substans eller vand 
ind i skærmen, så sluk straks for strømmen og 
tag stikker ud. Fjern derefter den fremmede 
substans eller vandet, og send skærmen til 
servicecenteret.
Skærmen må ikke bruges eller opbevares på 
steder, hvor den udsættes for varme, direkte 
sollys eller ekstrem kulde.
For at opretholde den bedste ydelse af din 
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skærm og for langvarig brug, så brug skærmen 
et sted, der er indenfor følgende temperatur- 
og fugtighedsområde. 
o  Temperatur : 0-40°C 32-95°F
o Fugtighed: 20-80% RH

VIGTIGT: Sørg altid for at aktivere en 
pauseskærm, der bevæger sig, når skærmen 
efterlades uden at blive anvendt. Du skal altid 
bruge en pauseskærm eller et andet program, 
der opdaterer skærmen regelmæssigt, hvis 
du viser statisk materiale i længere perioder. 
Uafbrudt visning af stille eller statiske billeder 
over en længere periode kan forårsage, at det 
“brændes fast” på skærmen, dvs. de såkaldte 
“spøgelsesbilleder” på din skærm. 
"Fastbrænding" og "spøgelsesbilleder" er 
velkendte fænomener inden for LCD-
skærmteknologien. “Fastbrænding” og 
“spøgelsesbilleder” forsvinder oftest gradvist 
efter en vis periode, efter skærmen er slukket. 

Advarsel
Imidlertid forsvinder alvorligere tilfælde af 
“fastbrænding” og “spøgelsesbilleder” ikke og kan 
ej heller fjernes ved reparation. Ovennævnte 
skader er ikke dækket af garantien.

Service
Kabinettet må kun åbnes af kvalificeret 
servicepersonale.
Hvis der er behov for et dokument til 
reparation eller integration, så kontakt 
dit lokale servicecenter. (Se kapitel om 
"Kundeinformationscenter")  
For oplysninger om transport, se "Tekniske 
specifikationer". 
Efterlad ikke din skærm i en bil/bagagerum 
under direkte sollys.

Bemærkning
Kontakt en servicetekniker, hvis skærmen ikke 
fungerer korrekt, eller hvis du er usikker på, hvad 
du skal gøre, når betjeningsinstruktionerne, der er 
givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser

Følgende underafsnit beskriver de 
notationsmæssige konventioner, der benyttes i 
dette dokument. 
Bemærkninger, forsigtighedsregler og advarsler
I hele denne vejledning kan tekstblokke være 
ledsaget af et ikon og stå med fed eller kursiv 
skrift. Disse blokke indeholder bemærkninger og 
punkter, hvor der skal udvises forsigtighed, eller 
advarsler. De anvendes som følger :

Bemærkning
Dette ikon angiver vigtige oplysninger og 
tips, hvormed du kan gøre bedre brug af 
computersystemet.

Forsigtig
Dette ikon angiver oplysninger om, hvordan du 
undgår risiko for skader på hardwaren eller tab af 
data.

Advarsel
Dette ikon angiver risiko for personskader og 
hvordan dette undgås.
Visse advarsler kan optræde i andre formater og 
er eventuelt ikke ledsaget af et ikon. I sådanne 
tilfælde er den givne udformning af advarslen 
lovmæssigt obligatorisk.
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1.3 Bortskaffelse af produkt og emballage

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its packaging 
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic 
appliances, this product may not be disposed 
of with normal household waste. You are 
responsible for disposal of this equipment through 
a designated waste electrical and electronic 
equipment collection. To determine the locations 
for dropping off such waste electrical and 
electronic, contact your local government office, 
the waste disposal organization that serves your 
household or the store at which you purchased 
the product.
Your new monitor contains materials that can be 
recycled and reused. Specialized companies can 
recycle your product to increase the amount of 
reusable materials and to minimize the amount to 
be disposed of. 
All redundant packing material has been omitted. 
We have done our utmost to make the packaging 
easily separable into mono materials.

Please find out about the local regulations on how 
to dispose of your old monitor and packing from 
your sales representative. 

Recycling Information for Customers
There is currently a system of recycling up and 
running in the European countries, such as The 
Netherlands, Belgium, Norway, Sweden and 
Denmark.
In Asia Pacific, Taiwan, the products can be taken 
back by Environment Protection Administration 
(EPA) to follow the IT product recycling 
management process, detail can be found in web 
site www.epa.gov.tw
The monitor contains parts that could cause 
damage to the nature environment. Therefore, it is 
vital that the monitor is recycled at the end of its 
life cycle. 
For help and service, please contact Consumers 
Information Center or F1rst Choice Contact 
Information Center in each country. 
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2.Opsætning af skærm

2.1 Installation

Emballagens indhold
202E2/202EL2

EDFU CD

Monitor Quick start guide

VGA signal cable Power cord 

Base Stand

202E

Monitor

202E2/202EL2

Note
Use only the AC/DC adapter model  ADPC1236/
FSP036-DGAA1/LCAP07F-2 

Installation af stander

202E2/202EL2

1. Anbring skærmen med forsiden vendt nedad 
på en jævn overflade, og vær forsigtig med ikke 
at ridse eller beskadige skærmen.

2. Hold skærmens fodstykke med begge hænder 
og sæt fodstykket ind i fodsøjlen med en fast 
hånd. 

CLICK!
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2.2 Brug af skærm

Produktbeskrivelse set forfra

 :   Således opnås der adgang til OSD-
menuen.

 :   Gå tilbage til forrige OSD-niveau.
 :   Skift til visning i 4:3.
 : Til at tænde og slukke for skærmen.
 : Således indstilles OSD-menuen.
 : Sådan ændres signalets indgangskilde.
 : SmartImage Lite. Der kan vælges 

mellem tre tilstande: Standard, Internet 
og Spil.

Tilslutning til PC

  AC strømindgang

  VGA-indgang
DVI-D input (tilgængelig i udvalgte 
modeller)

  Kensington anti-tyverisikring

Tilslutning til pc

1.   Tilslut elledningen ordentligt pa bagsiden 
af skarmen.

2.   Sluk for computeren og tag netledningen 
ud af stikket.

3.   Slut skærmens signalkabel til videostikket 
bag på computeren.

4.   Sæt computerens og skærmens 
netledninger til et stik i nærheden.

5.   Tænd for computeren og skærmen. Hvis 
skærmen viser et billede, er installationen 
gennemført.
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Beskrivelse af OSD-displayet

Hvad er OSD (On-Screen Display)?

Visning på skærmen [On-Screen Display (OSD)] 
er en funktion på alle Philips LCD-skærme. 
Den sætter en slutbruger i stand til at justere 
skærmindstilling eller vælge skærmens funktioner 
direkte via et instruktionsvindue direkte på 
skærmen. Et brugervenligt skærmvisningsinterface 
vises som nedenfor:

Grundlæggende og enkle anvisninger til 
kontrolknapperne

På OSD-skærmen, der er vist ovenfor, kan brugere 
trykke på -knapperne på skærmens frontkant 
for at bevæge cursoren, OK for at bekræfte valget 
eller for at ændre.

OSD-menuen
Nedenstående er en generel oversigt over 
strukturen i OSD-displayet. Du kan anvende den 
som opslag, når du senere skal orientere dig i de 
forskellige justeringer.

Main menu

Auto

Sub menu

Input
VGA

DVI (available for selective models)

Picture
Wide screen,4:3

0~100

0~100

On, Off

Picture Format

Brightness

Contrast

SmartContrast

OSD Setting
0~100

0~100

Off, 1, 2, 3, 4

5, 10, 20, 30, 60

Horizontal

Vertical

Transparency

OSD Time out

Setup

0~100

On, Off

Yes, No

0~100

0~100

0~100

H. Position

V. Position

Phase

Clock

Resolution Notification

Reset

Information

Language English Español, Français, Deutsch, Italiano,

Português, Русский Türkçe

Color
6500K, 9300K

Red: 0~100

Green: 0~100

Blue: 0~100

Color Temp.

sRGB

User Define



7

Meddelelse om opløsning

Denne skærm er designet til optimal ydelse 
ved dens naturlige opløsning: 1600x900@60Hz. 
Når skærmen køres på en anden opløsning, 
ses følgende advarsel på skærmen: De bedste 
resultater opnås med 1600x900@60Hz.
Advarslen vedrørende den naturlige opløsning 
kan deaktiveres under Installation i OSD 
(skærmmenuen).

Fysisk funktion

Vip

(202E2/202EL2)

2.3 Fjern basens fod og base

Fjern fodstykket

Inden du begynder adskillelse af skærmens fod, 
skal du følge vejledningerne nedenfor for at undgå 
beskadigelse og personskade

1. Anbring skærmen på en jævn overflade med 
forsiden vendt nedad og vær forsigtig med at 
undgå at ridse eller beskadige skærmen.

2..Tryk på låseclipsene for at frakoble fodstykket 
fra fodsøjlen.
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Fjern foden

Betingelse:

1.  Fjern de 4 skruehætter..  

2.  Fjern de 4 skruer og fjern derefter foden fra 
skærmen.  

Bemærkning
Denne skærm accepterer et 100 x 100 mm VESA-
kompliant monteringsinterface.

100mm

100mm
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3. Produktinformation

3.1 Smart-billede Lite

Hvad er dette?

Smart-billede Lite er forvalgte indstillinger, der 
optimerer skærmen i henhold til indholdet, og 
som realtid dynamisk indstiller lysstyrke, kontrast, 
farve og skarphed. Uanset om du arbejder med 
tekstprogrammer, ser billeder eller ser video, 
så giver Philips SmartImage Lite den optimale 
skærmydelse. 

Hvorfor behøver jeg det? 

Du ønsker en skærm, som giver det bedste 
billede for alle typer indhold. For at øge skærm-
oplevelsen, indstiller SmartImage Lite-softwaret
dynamisk lysstyrke, kontrast, farve og skarphed i 
realtid.

Hvordan virker det? 

Smart-billede Lite er en eksklusiv, førende Philips-
teknologi, som analyserer indholdet på skærmen. 
Ud fra det valgte scenarie forbedrer SmartImage 
Lite dynamisk billeders og videoers kontrast, 
farvemæthed og skarphed for at forbedre det 
viste billede - alt i realtid og blot med et tryk på 
en knap. 

Hvordan aktiveres Smart-billede Lite?

202E

1. Tryk på  for at starte Smart-billede Lite på 
skærmen;

2. Fortsæt med at trykke på  for at skifte 
mellem Standard (Standard), Internet 
(Internet),Game (Spil).

3. Smart-billede Lite ses på skærmen i fem 
sekunder, men du kan også trykke på OK for 
at bekræfte.

4. Når Smart-billede Lite er aktiveret, deaktiveres 
sRGB systemet automatisk. For at bruge sRGB 
skal du deaktivere Smart-billede Lite med
foran på skærmen.

Udover at bruge  til at rulle ned med, kan du 
også trykke på  for at vælge og derefter trykke 
på OK for at bekræfte valget og derefter igen 
lukke Smart-billede OSD.
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Der kan vælges mellem 3 tilstande: Standard
(Standard), Internet (Internet),Game (Spil).

Standard (Standard): Forbedrer teksten og 
dæmper lysstyrken for at øge læsbarheden 
og nedsætte anstrengelsen af øjnene. Denne 
tilstand øger afgørende læsbarheden og 
produktiviteten, når der arbejdes med 
regneark, PDF filer, skannede artikler og andre 
generelle kontorprogrammer. 
Internet (Internet): Denne profil kombinerer 
farvemæthed og dynamisk kontrast og 
skarphed for at vise billeder og lignende 
overordentlig klart og i levende farver - alt 
uden synlige fejl i det indskannede billede og 
blegnede farver.
Game (Spil): Aktivér overdrive-kredsløbet for 
at få den bedste reaktionstid, reducere skæve 
kanter for genstande, der bevæger sig hurtigt 
på skærmen, forbedre kontrastforholdet for 
lys og mørke. Denne profil giver spillere den 
bedste oplevelse af spil. 

3.2 Smart-kontrast

Hvad er dette? 

Unik teknologi, der dynamisk analyserer det 
viste indhold og automatisk optimerer LCD 
skærmens kontrastforhold til maksimal visuel 
klarhed. Den øger baggrundsbelysningen og 
giver et klarere, friskere og lysere billede eller 
dæmper baggrundsbelysningen med henblik på 
en tydelig visning af billeder på mørk baggrund. 

Hvorfor behøver jeg det? 

Du ønsker den allerbedste visuelle klarhed 
og visning ved enhver type indhold. Smart-
kontrast styrer dynamisk kontrast og indstiller 
baggrundslyset, så det giver klare, friske og lyse 
spil- og videobilleder og viser tydelig, læsbar tekst 
ved kontorarbejde. Ved at nedsætte skærmens 
strømforbrug, sparer du energiomkostninger og 
forlænger skærmens levetid. 

Hvordan virker det? 

Når du aktiverer SmartContrast, analyseres 
det viste indhold i realtid for at indstille farver 
og baggrundslysets intensitet. Denne funktion 
forbedrer dynamisk kontrasten og giver således en 
bedre underholdningsoplevelse, når du ser videoer 
eller spiller spil.
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Guide for første start
Efter installation af SmartControl Lite åbnes 
guiden automatisk, når du åbner programmet 
første gang. 
Guiden leder dig trin for trin gennem indstilling 
af skærmen. 
Du kan også gå til Plug-in menuen for at starte 
guiden på et senere tidspunkt. 
I Standard-ruden kan du indstille flere 
funktioner uden guide.

3.3 Philips SmartControl Lite

Det nye SmartControl Lite-software fra Phillips 
giver dig mulighed for at kontrollere skærmen via 
et nemt, grafisk interface.  Komplicerede justeringer 
hører fortiden til. Dette brugervenlige software 
guider dig gennem finindstilling af opløsning, 
kalibrering af farve, justeringer af clockning/fase, 
RGB-hvidpunkt osv.  

Udstyret med den seneste teknologi i algoritmer 
for hurtig behandling og reaktion, er denne 
iøjnefaldende, ikon-baserede software, der også er 
Windows 7 parat, klar til at forbedre din oplevelse 
med Philips-skærme!

Installation

Følg instruktionen og fuldfør installationen. 
Du kan starte, når installationen er fuldført. 
Hvis du vil begynde senere, kan du klikke 
på genvejen på skrivebordet eller på 
værktøjslinjen.
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Start med Standard-rude:

Adjust menu (Indstillingsmenu):
Med "Adjust" ("Indstilling"-)menuen kan du 
indstille Brightness (Lysstyrke), Contrast 
(Kontrast), Focus (Fokus), Position (Position) 
og Resolution (Opløsning). 
Foretag indstillingen ved at følge 
instruktionerne. 

(Annuller). 
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Farvemenu: 

Med "Color" ("Farve"-)menuen kan du 
indstille RGB, Black Level (Sortniveau), 
White Point (Hvidpunkt), Color Calibration 
(Farvekalibrering) og Smart-Billede (se 
afsnittet Smart-Billede). 
Foretag indstillingen ved at følge 
instruktionerne. 
Se nedenstående oversigt med 
undermenupunkter baseret på dit input. 
Eksempel på Color Calibration 
(Farvekalibrering)

1. "Show Me" ("Vis Mig") starter vejledningen i 
farvekalibrering. 

2. "Start" - starter 6-trins farvekalibrerings-
sekvensen. 

3. "Quick View" ("Quick-visning") indlæser før/
efter-billederne. 

4. For at vende tilbage til "Color" ("Farve"-)
startruden, skal du klikke på "Cancel" 
("Annuller"). 

5. Aktiver farvekalibrering - der som standard 
er aktiveret. Hvis markeringen er fjernet, kan 
der ikke ske farvekalibrering, ligesom start- og 
quick-visning knapperne er gråtonede. 

6. Der skal være patent-oplysninger på 
kalibreringsskærmen.
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Først farvekalibreringsskærm: 

"Previous" ("Foregående"-) knap er 
deaktiveret, indtil den anden farveskærm. 
"Next" ("Næste") går til efterfølgende mål 
(seks mål). 
"Final next" ("Afsluttende Næste) går til 
File > Presets (File > Forvalg) rude. 
"Cancel" ("Annuller") lukker UI og vender 
tilbage til "plug in"-) siden.

Smart-billede 
Smart-Billede - tillader brugeren at 
ændre indstillingen for at opnå en bedre 
skærmindstilling baseret på indhold.

Når der indstilles på "Entertainment" 
("Underholdning"), aktiveres Smart-Kontrast 
og Smart-Svar.

"Options > Preferences" ("Funktioner > 
Indstillinger") - er kun aktiv, når Preferences 
(Indstillinger) er valgt i "Options" 
("Funktioner"-) rullemenuen-rullemenuen. 
På en ikke-understøttet skærm med DDC/
Ci er kun "Help" ("Hjælp") og "Options" 
("Funktioner") til rådighed.

Viser nuværende, foretrukne indstillinger. 
Funktionen aktiveres ved at afmærke 
feltet. Afmærkningsfeltet er en flip-flop. 
"Enable Task Tray" ("Aktiver Jobbakke") 
menuen er som standard afmærket (Til) 
på skrivebordet. Menuen Enable Context 
(Aktivér kontekst) viser valgmulighederne 
i SmartControl Lite for Select Preset 
(Vælg Forvalg) og Tune Display (Indstil 
Display) i genvejmenuen ved højreklik 
på skrivebordet. Disabled (Deaktiveret) 
fjerner SmartControl Lite fra kontekst-
genvejsmenuen. 
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"Enable Context" ("Aktiver Indhold"-) 
menuen er som standard afmærket (Til) 
på skrivebordet. Menuen Enable Context 
(Aktiver Indhold) gør, at systembakkens ikon 
for SmartControl Lite vises. Et højreklik på 
jobbakke-ikonen viser menufunktionerne 
for "Help" ("Hjælp") og "Technical Support" 
("Teknisk Støtte"). Afmærk for "Upgrade" 
("Opgradering"), "About" ("Om") og "Exit" 
("Afslut"). Når "Enable Task Tray" ("Aktiver 
Jobbakke") menuen er deaktiveret, viser 
jobbakke-ikonen kun EXIT (AFSLUT). 
"Run at Startup" ("Kør ved Startop") er 
som standard afmærket (Til). Når den 
er deaktiveret, starter SmartControl Lite 
ikke ved starten og ikonet vises ikke i 
systembakken. SmartControl Lite kan kun 
startes fra genvejen på skrivebordet eller 
fra programfilen. Intet forvalg, indstillet til at 
køre ved startop, indlæses, når denne boks 
ikke er afmærket (er deaktiveret). 
Aktivér gennemsigtighedstilstand 
(Windows 7, Vista, XP). Standard er 0% 
uigennemsigtighed.

"Options > Input" ("Funktioner > Indgang") 
- er kun aktiv, når "Input" ("Indgang") er valgt i 
"Options" ("Funktioner"-)rullemenuen. På en 
ikke-understøttet skærm med DDC/Ci er kun 
"Help" ("Hjælp") og "Options" ("Funktioner") til 
rådighed. Alle andre faneblade i SmartControl 
Lite er ikke til rådighed.

Vis "Source" ("Kilde") instruktionsruden og 
nuværende indgangskilde indstilling. 
Ved enkeltindgangsskærme ses denne rude 
ikke."

Options > Audio" ("Funktioner > Lyd") - er 
kun aktiv, når "Volume" ("Lydstyrke") er valgt i 
"Options" ("Funktioner"-)rullemenuen.
På en ikke-understøttet skærm med DDC/Ci er 
kun "Help" ("Hjælp") og "Options" ("Funktioner") 
til rådighed. 
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"Help > User Manual" ("Hjælp > 
Brugervejledning") - er kun aktiv, når "User 
Manual" ("Brugervejledning") er valgt i "Help" 
("Hjælp"-)rullemenuen. På en ikke-understøttet 
skærm med DDC/Ci er kun "Help" ("Hjælp") 
og "Options" ("Funktioner") til rådighed.

"Options > Version" ("Funktioner > Version") 
- er kun aktiv, når "Version" ("Version") er valgt 
i "Help" ("Hjælp"-)rullemenuen. På en ikke-
understøttet skærm med DDC/Ci er kun 
"Help" ("Hjælp") og "Options" ("Funktioner") til 
rådighed.

Context Sensitive (Indholdssensitiv) menu
"Context Sensitive" ("Indholdssensitiv") menuen 
er som standard aktiveret. Hvis "Enable Context" 
("Aktiver Indholdssensitiv") menuen er afmærket 
i "Options > Preferences" ("Funktioner > 
Indstillinger") ruden, ses menuen.

"Context" ("Indhold") menuen har fire punkter
SmartControl Lite - når valgt, ses "About" 
("Om") skærmen. 
"Select Preset" ("Vælg Forvalgt") - en 
hierakisk menu med gemte forvalg, der 
straks kan bruges. En afkrydsniong viser 
det i øjeblikket valgte forvalg. "Factory 
Preset" ("Fabriksforvalg") kan også hentes i 
rullemenuen. 
Tune Display (Indstil Skærm) - åbner 
kontrolpanelet for SmartControl             . 
SmartImage - Kontrollér aktuelle 
indstillinger for Standard (Standard), Internet 
(Internet),Game (Spil).
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"Task Tray" ("Jobbakke"-) menu aktiveret
Menuen i systembakken kan ses ved at 
højreklikke på SmartControl Lite-ikonet 
i systembakken. Et venstreklik starter 
programmet.

Jobbakken har fem punkter :
"Help" ("Hjælp") - adgang til 
brugervejledning-fil: Åbner 
Brugervejledningen med standard 
browservinduet. 
"Technical Support" ("Teknisk Hjælp") - 
viser siden med teknisk hjælp. 
"Check for Update " ("Tjek for 
opdateringer") - leder brugeren til PDI 
Landing og tjekker brugerens version i 
forhold til den allernyeste version. 
"About" ("Om") - viser detaljerede 
referenceoplysninger : Produktversion, 
frigivelses-information og produktnavn. 
Exit (Afslut) - Luk SmartControl Lite
Hvis du vil køre To run SmartControl Lite 
igen, skal du enten vælge SmartControl 
Lite i programmenuen, dobbeltklikke på 
skrivebordet eller genstarte systemet.

"Task Tray" ("Jobbakke"-)menu deaktiveret
Når "Task Tray" ("Jobbakke") er deaktiveret 
i indstillinger-mappen, er kun valg af "EXIT" 
("AFSLUT") til rådighed. Hvis du helt vil fjerne 
SmartControl Lite fra systembakken, skal du 
deaktivere "Run at Startup" ("Kør ved Startop") 
i "Options > Preferences" ("Muligheder > 
Indstillinger").  
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3.4  Philips' regler ved pixeldefekter på 
fladskærme

Philips tilstræber at levere produkter af den 
højeste kvalitet. Vi anvender nogle af branchens 
mest avancerede produktionsprocesser og udfører 
en streng kvalitetskontrol. En gang imellem er 
defekte pixler eller sub-pixler på TFT LCD-skærme 
dog uundgåelige. Ingen producent kan garantere, 
at alle paneler vil være fri for pixeldefekter, 
men Philips garanterer, at enhver skærm med 
et uacceptabelt antal defekter repareres eller 
udskiftes under garantien. Dette notat forklarer de 
forskellige former for pixeldefekter og definerer 
de acceptable defektniveauer for hver type. For 
at være berettiget til reparation eller udskiftning 
under garantien skal antallet af pixeldefekter på en 
TFT LCD- fladskærm overskride disse acceptable 
niveauer. For eksempel må højst 0,0004% af 
sub-pixlerne på en 20" XGA-skærm være 
defekte. Desuden sætter Philips endnu højere 
kvalitetsnormer for visse typer eller kombinationer 
af pixeldefekter, derer mere generende end andre. 
Denne pixelpolitik gælder i hele verden.

Pixler og sub-pixler 
En pixel eller et billedelement er sammensat af tre 
sub-pixler med primærfarverne rød, grøn og blå. 
Når mange pixler sættes sammen, kan de danne et 
billede. Når alle sub-pixler i en pixel lyser, fremstår 
de farvede sub-pixler tilsammen som enkelt 
hvid pixel. Hvis de alle er mørke, fremstår de tre 
farvede sub-pixler tilsammen som en enkelt sort 
pixel. Andre kombinationer af oplyste og mørke 
sub-pixler fremstår som enkelte pixler i andre 
farver.

Forskellige typer pixeldefekter 
Pixel- og sub-pixeldefekter optræder på skærmen 
på forskellige måder. Der er to kategorier af 
pixeldefekter og flere typer sub-pixeldefekter i 
hver kategori. 

Defekte lyse prikker
Defekte lyse prikker fremkommer som pixels eller 
underpixels, der altid lyser eller er "på". Det vil 
sige, at en lys prik er en underpixel, der fremstår 
på skærmbilledet, når skærmen viser et mørkt 
mønster. Der er følgende typer defekte lyse 
prikker :

En tænd rød, grøn eller blå sub-pixel

To sammenliggende tændte sub-pixler :
- Rød + Blå = Lilla
- Rød + Grøn = Gul
- Grøn + Blå = Cyan (Lyseblå)

Tre sammenliggende tændte pixler (en hvid pixel)
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Bemærkning

En rød eller blå lys prik skal være mere end 50 
procent lysere end de omkringliggende prikker, 
mens en grøn lys prik er 30 procent lysere end de 
omkringliggende prikker.

Defekte mørke prikker
Defekte mørke prikker fremkommer som pixels 
eller underpixels, der altid er mørke eller "fra". Det 
vil sige, at en lys prik er en underpixel, der fremstår 
på skærmbilledet, når skærmen viser et mørkt 
mønster. Der er følgende typer defekte mørke 
prikker :

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU
MODEL 202E2/202EL2
1 tændt sub-pixel 3
2 sammenliggende tændte sub-pixler 1
Tre sammenliggende tændte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU
MODEL 202E2/202EL2
1 mørk sub-pixel 5 eller færre
2 sammenliggende mørke sub-pixler 2 eller færre
3 sammenliggende mørke sub-pixler 0
Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller færre

SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU
MODEL 202E2/202EL2
Samlede bright- eller black dot-defekter af alle typer 5 eller færre

Bemærkning
1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
Denne monitor er i overensstemmelse med ISO9241-307

Tætliggende pixeldefekter 
Da pixel- og sub-pixeldefekter af samme type, 
der ligger tæt på hinanden, kan være mere 
iøjnefaldende, specificerer Philips også tolerancer 
for tætliggende pixeldefekter.

Pixeldefekttolerancer
For at være berettiget til reparation eller 
udskiftning på grund af pixeldefekter i 
garantiperioden skal et TFT LCD-panel i en Philips 
fladskærm have pixel- eller sub-pixeldefekter, 
der overskrider de tolerancer, der er gengivet i 
følgende tabeller.
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4 Tekniske specifikationer

202E2/202EL2

Billede/Skærm
Panel af LCD-typen TFT-LCD
Baggrundslys CCFL(202E2)/LED(202EL2)
Panelstørrelse 20'' W (50,8 cm)
Aspektforhold 16:9
Pixel pitch 0,2768 x 0,2768 mm
Lysstyrke 250 cd/m²
Smart-kontrast 500000:1(202E2)/20000000:1(202EL2)
Kontrastforhold (typ.) 1000:1
Reaktionstid (normal)  5 ms
Optimal opløsning 1600x900 @ 60 Hz
Synsvinkel 176° (H) / 170° (V) @ C/R > 5
Billedforbedring SmartImage Lite
Skærmfarver 16,7 M
Vertikal opdateringshastighed 56 -76 Hz 
Horisontal frekvens 30 - 80 kHz
sRGB JA
Tilslutningsmuligheder
Signalinput DVI-D (digital, HDCP), VGA (analog)
Inputsignal Separat synk., synk. på grøn
Behagelighed
Brugerfunktioner

OSD sprog Engelsk, fransk, tysk, italiensk, russisk, spansk, simplificeret kinesisk 
og portugisisk tyrkisk

Andre funktioner kensington-lås
"Plug & Play" kompatibilitet DDC/CI, sRGB, Windows 7/2000/XP/Vista, Mac OS X 
Fod
Vip -5/+20 (202E2/202EL2)
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Strøm(202E2)
Tændt-tilstand 22,37W(typisk)
Energiforbrug
(EnergyStar 5.0 testmetode) 

AC 
indgangsspænding
ved 
100VAC +/- 5VAC, 
50Hz +/- 3Hz

AC 
indgangsspænding
115VAC +/- 5VAC, 
60Hz +/- 3Hz

AC 
indgangsspænding
230VAC +/- 5VAC, 
50Hz +/- 3Hz

Normal funktion (typisk) 19,63W 19,62W 19,60W

Sovetilstand 0,5W 0,5W 0,5W
Fra 0,5W 0,5W 0,5W
Varmetab* AC 

indgangsspænding
ved 
100VAC +/- 5VAC, 
50Hz +/- 3Hz

AC 
indgangsspænding
115VAC +/- 5VAC, 
60Hz +/- 3Hz

AC 
indgangsspænding
230VAC +/- 5VAC, 
50Hz +/- 3Hz

Normal drift 82,13BTU/hr 82,09BTU/hr 82,06BTU/hr
Sovetilstand 2,09BTU/hr 2,09BTU/hr 2,09BTU/hr
Fra 2,09BTU/hr 2,09BTU/hr 2,09BTU/hr
Strøm(202EL2)
Tændt-tilstand 20,25W(typisk)
Energiforbrug
(EnergyStar 5.0 testmetode) 

AC 
indgangsspænding
ved 
100VAC +/- 5VAC, 
50Hz +/- 3Hz

AC 
indgangsspænding
115VAC +/- 5VAC, 
60Hz +/- 3Hz

AC 
indgangsspænding
230VAC +/- 5VAC, 
50Hz +/- 3Hz

Normal funktion (typisk) 17,30W 17,27W 17,26W
Sovetilstand 0,5W 0,5W 0,5W
Fra 0,5W 0,5W 0,5W
Varmetab* AC 

indgangsspænding
ved 
100VAC +/- 5VAC, 
50Hz +/- 3Hz

AC 
indgangsspænding
115VAC +/- 5VAC, 
60Hz +/- 3Hz

AC 
indgangsspænding
230VAC +/- 5VAC, 
50Hz +/- 3Hz

Normal drift 72,38BTU/hr 72,25BTU/hr 72,22BTU/hr
Sovetilstand 2,09BTU/hr 2,09BTU/hr 2,09BTU/hr
Fra 2,09BTU/hr 2,09BTU/hr 2,09BTU/hr
Strømdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker) 
Strømforsyning Indbygget, 100-240VAC, 50/60Hz
Mål
Produkt uden fod (BxHxD) 494 x 386 x199 mm
Produkt uden fod (BxHxD) 494 x 316 x 49 mm
Kassemål (BxHxD) 565 x 446 x 143 mm
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Vægt
Produkt med fod 3,96 kg
Produkt uden fod 3,8 kg
Produkt med emballage 5,28 kg
Driftsforhold
Temperaturområde (drift) 0°C til 40°C
Temperaturområde (Ikke drift) -20°C til 60°C
Relativ fugtighed 20% til 80%
Højde Drift: + 12.000 ft (3.658 m)

Ikke drift: + 40.000 ft (12.192 m)

MTBF 50.000 timer(202E2)/30.000 timer(202EL2)

Miljømæssige forhold
ROHS JA
EPEAT Sølv. (www.epeat.net)
Emballage 100% genbrugelig
Overholdelse og standarder
Myndighedernes godkendelser CE Mark, Energy Star 5.0, FCC Class B, SEMKO,  TÜV/ GS, TÜV 

Ergo, UL/cUL, TCO5.0
Kabinet
Farve Sort/sort
Finish Blank/Blank

Bemærkning
1. EPEAT Silver er kun gyldigt, hvor Philips har registreret produktet. 
   Gå til www.epeat.net for registreringsstatus i dit land.
2. Disse data kan ændres uden meddelelse derom. 
   Gå til www.philips.com/support for at hente den seneste version af brochuren.
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4.1 Opløsning og forvalgte indstillinger

Maksimal opløsning 

Til 202E2/202EL2
1600x900 ved 60 Hz (analogt input)
1600x900 ved 60 Hz (digital indgang)

Anbefalet opløsning

Til 202E2/202EL2
1600x900 ved 60 Hz (digital indgang)

V frekv (kHzx) Opløsning L frekv (Hz)
31.47 720x400 70.09
31.47 640x480 59.94
35.00 640x480 66.67
37.86 640x480 72.81
37.50 640x480 75.00
37.88 800x600 60.32
46.88 800x600 75.00
48.36 1024x768 60.00
60.02 1024x768 75.03
44.77 1280x720 59.86
49.70 1280x800 59.81
63.89 1280x1024 60.02
79.98 1280x1024 75.03
60.00 1600x900 60.00

4.2 Automatisk energispare

Hvis der er installeret et VESA DPM overholdende 
skærmkort eller software på pc'en, kan skærmen 
automatisk nedsætte strømforbruget, når den 
ikke bruges. Når input fra tastatur, mus eller 
anden input-enhed registreres, "vågner" skærmen 
automatisk igen. Nedenstående tabel viser denne 
automatiske energisparefunktions strømforbrug og 
signalering:

Energispare-definition
VESA tilstand Video V synk L synk Forbrugt 

strøm
Diodefarve 

Aktiv TIL Ja Ja 202E2<
22,37 W 
(norm.)

202EL2<
20,25 W 
(norm.)

Hvid

Sovetilstand FRA Nej Nej < 0,5 W 
(norm.) 

Hvid
(blinker)

Kontakt Fra FRA - - < 0,5 W 
(norm.)

FRA

Denne skærm opfylder ENERGY STAR®-kravene. Som ENERGY STAR®

partner har vi fastlagt, at dette produkt opfylder retningslinjerne ENERGY 
STAR® lavt strømforbrug.

Den følgende opsætning bruges ti l at måle 
skærmens strømforbrug.

Indbyggede opløsning: 1600x900.
Kontrast: 50%
Lysstyrke: 250 nits
Farvetemperatur : 6500k med fuldt, hvidt mønster
Lyd (fra)

Bemærkning
Disse data kan ændres uden meddelelse derom.



24

5 Lovmæssige oplysninger

Lead-free Product

Lead free display promotes 
environmentally sound recovery and 
disposal of waste from electrical and 
electronic equipment. Toxic substances 

like Lead has been eliminated and compliance with 
European community’s stringent RoHs directive 
mandating restrictions on hazardous substances 
in electrical and electronic equipment have been 
adhered to in order to make Philips monitors safe 
to use throughout its life cycle.

TCO Displays 5.0 Information

Congratulations, 
Your display is designed for both you 
and the planet!

This display carries the TCO Certified label. This 
ensures that the display is designed for minimal 
impact on the climate and natural environment, 
while offering all the performance expected 
from top of the line electronic products. TCO 
Certified is a third party verified program, where 
every product model is tested by an accredited 
independent test laboratory. TCO Certified 
represents one of the toughest certifications for 
displays worldwide.

Some of the Usability features of the TCO 
Displays 5.0 requirements:

Visual Ergonomics
Good visual ergonomics in order to improve the 
working environment for the user and to reduce 
sight and strain problems. Important parameters 
are:

and luminance, Wide color gamut 

curve 

motion blur 

Electrical Safety

Emissions

emissions

Some of the Environmental features of the 
TCO Displays 5.0 requirements: 

social responsibility and has a certified 
environmental management system (EMAS or 
ISO 14001) 

standby mode 

flame retardants, plasticizer and polymers 

mercury and lead (RoHS compliance)
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EPEAT 
(www.epeat.net)

“The EPEAT (Electronic Product 
Environmental Assessment Tool) 
program evaluates computer 
desktops, laptops, and monitors based 

on 51 environmental criteria developed through 
an extensive stakeholder consensus process 
supported by US EPA.
EPEAT system helps purchasers in the public 
and private sectors evaluate, compare and select 
desktop computers, notebooks and monitors 
based on their environmental attributes. EPEAT 
also provides a clear and consistent set of 
performance criteria for the design of products, 
and provides an opportunity for manufacturers to 
secure market recognition for efforts to reduce 
the environmental impact of its products.”
Benefits of EPEAT
Reduce use of primary materials
Reduce use of toxic materials
Avoid the disposal of hazardous waste EPEAT’S 
requirement that all registered products meet 
ENERGY STAR’s energy efficiency specifications, 
means that these products will consume less 
energy throughout their life.

CE Declaration of Conformity
This product is in conformity with the following 
standards

EN60950-1:2006 (Safety requirement of 
Information Technology Equipment) 
EN55022:2006 (Radio Disturbance 
requirement of Information Technology 
Equipment)
EN55024:1998+A1:2001+A2:2003 (Immunity 
requirement of Information Technology 
Equipment)
EN61000-3-2:2006 (Limits for Harmonic 
Current Emission) 
EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker) 
following provisions of directives applicable
2006/95/EC (Low Voltage Directive) 
2004/108/EC (EMC Directive) 
2005/32/EC (EuP Directive, EC No. 1275/2008 

mplementing Directive for Standby and Off 
mode power consumption) and is produced 
by a manufacturing organization on ISO9000 
level. 
  The product also comply with the following 
standards
ISO9241-307:2008 (Ergonomic requirement, 
Analysis and compliance test methods for 
electronic visual displays)  
GS EK1-2000:2009 (GS mark requirement)
prEN50279:1998 (Low Frequency Electric and 
Magnetic fields for Visual Display) 
MPR-II (MPR:1990:8/1990:10 Low Frequency 
Electric and Magnetic fields) 
TCO Displays 5.0 (Requirement for 
Environment Labeling of Ergonomics,  
Energy,  Ecology and Emission, TCO: Swedish 
Confederation of Professional Employees)  for 
TCO versions.

This monitor is equipped with a function for saving 
energy which supports the VESA Display Power 
Management (DPM) standard. This means that the 
monitor must be connected to a computer which 
supports VESA DPM. Time settings are adjusted 
from the system unit by software.

VESA State LED Indicator Power 
Consumption

Normal 
operation

ON (Active) White 202E2< 19,62 W 
(typ.)

202EL2< 17.27 
W (typ.)

Power Saving 
Alternative 2 
One step

Sleep Switch Off White(blink)
Off

< 0.5 W (typ.)
< 0.5 W (typ.)

As an ENERGY STAR® Partner, 
we have determined that this 
product meets the ENERGY STAR®

guidelines for energy efficiency.

Note
We recommend you switch off the monitor when 
it is not in use for a long time.
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Federal Communications Commission (FCC) 
Notice (U.S. Only)

  This equipment has been tested and found 
to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide 
reasonable protection against harmful 
interference in a residential installation. This 
equipment generates, uses and can radiate 
radio frequency energy and, if not installed 
and used in accordance with the instructions, 
may cause harmful interference to radio 
communications. However, there is no 
guarantee that interference will not occur 
in a particular installation. If this equipment 
does cause harmful interference to radio or 
television reception, which can be determined 
by turning the equipment off and on, the 
user is encouraged to try to correct the 
interference by one or more of the following 
measures:
Reorient or relocate the receiving antenna. 
Increase the separation between the 
equipment and receiver. 
Connect the equipment into an outlet on 
a circuit different from that to which the 
receiver is connected. 
Consult the dealer or an experienced radio/
TV technician for help.

  Changes or modifications not expressly 
approved by the party responsible for 
compliance could void the user's authority to 
operate the equipment.

Use only RF shielded cable that was supplied with 
the monitor when connecting this monitor to a 
computer device. 
To prevent damage which may result in fire or 
shock hazard, do not expose this appliance to rain 
or excessive moisture. 
THIS CLASS B DIGITAL APPARATUS MEETS 
ALL REQUIREMENTS OF THE CANADIAN 
INTERFERENCE-CAUSING EQUIPMENT 
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked 
with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 
Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that 
may cause undesired operation. 
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Commission Federale de la Communication 
(FCC Declaration)

  Cet équipement a été testé et déclaré 
conforme auxlimites des appareils numériques 
de class B,aux termes de l'article 15 Des 
règles de la FCC. Ces limites sont conçues 
de façon à fourir une protection raisonnable 
contre les interférences nuisibles dans le cadre 
d'une installation résidentielle. 

  CET appareil produit, utilise et peut émettre 
des hyperfréquences qui, si l'appareil n'est pas 
installé et utilisé selon les consignes données, 
peuvent causer des interférences nuisibles aux 
communications radio. 

  Cependant, rien ne peut garantir l'absence 
d'interférences dans le cadre d'une installation 
particulière. Si cet appareil est la cause 
d'interférences nuisibles pour la réception des 
signaux de radio ou de télévision, ce qui peut 
être décelé en fermant l'équipement, puis en 
le remettant en fonction, l'utilisateur pourrait 
essayer de corriger la situation en prenant les 
mesures suivantes:
Réorienter ou déplacer l'antenne de réception. 
Augmenter la distance entre l'équipement et 
le récepteur. 
Brancher l'équipement sur un autre circuit que 
celui utilisé par le récepteur. 
Demander l'aide du marchand ou d'un 
technicien chevronné en radio/télévision.

  Toutes modifications n'ayant pas reçu 
l'approbation des services compétents 
en matière de conformité est susceptible 
d'interdire à l'utilisateur l'usage du présent 
équipement.

N'utiliser que des câbles RF armés pour 
les connections avec des ordinateurs ou 
périphériques. 
CET APPAREIL NUMERIQUE DE LA CLASSE 
B RESPECTE TOUTES LES EXIGENCES DU 
REGLEMENT SUR LE MATERIEL BROUILLEUR 
DU CANADA. 

EN 55022 Compliance (Czech Republic Only)
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Polish Center for Testing and Certification 
Notice

The equipment should draw power from a socket 
with an attached protection circuit (a three-
prong socket). All equipment that works together 
(computer, monitor, printer, and so on) should 
have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.

A protection mark "B" confirms that the 
equipment is in compliance with the protection 
usage requirements of standards PN-93/T-42107 
and PN-89/E-06251.

North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR DU 
STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL: 
S Ø R G  V E D  P L AC E R I N G E N  F O R , AT 
NETLEDNINGENS STIK OG STIKKONTAKT ER 
NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS: 
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VO IDAAN TARV ITTAESSA  HELPOST I 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL:
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE  PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den 
in der "Verordnung über den Schutz vor Schäden 
durch Röntgenstrahlen" festgelegten Vorschriften. 

Auf der Rückwand des Gerätes befindet sich 
ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften über 

Abs. 4 der Röntgenverordnung erfüllt sind. 

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß 

1. Reparaturen nur durch Fachpersonal 
durchgeführt werden. 

2. nur original-Ersatzteile verwendet werden. 

3. bei Ersatz der Bildröhre nur eine bauartgleiche 
eingebaut wird. 

Aus ergonomischen Gründen wird empfohlen, 
die Grundfarben Blau und Rot nicht auf dunklem 
Untergrund zu verwenden (schlechte Lesbarkeit 
und erhöhte Augenbelastung bei zu geringem 
Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel nach 
DIN 45 635 beträgt 70dB (A) oder weniger. 

ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 

China RoHS 

The People's Republic of China released a 
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
RoHS. All products including CRT and LCD 
monitor which are produced and sold for China 
market have to meet China RoHS request.
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6 Kundeservice og garanti
Kundeservice og garanti

VÆLG DIT LAND/OMRÅDE FOR AT SE 
OPLYSNINGER OM DIN GARANTIDÆKNING

VESTEUROPA
Østrig / Belgien / Danmark / Frankrig / Tyskland 
/ Grækenland / Finland / Irland / Italien / 
Luxembourg / Holland / Norge / Portugal / 
Sverige / Schweiz / Spanien / Storbritannien / 
Polen

ØSTEUROPA
Tjekkiet / Ungarn / Rusland / Slovakiet / Slovenien 
/ Tyrkiet

LATINAMERIKA
Argentina / Brasilien

NORDAMERIKA
Canada / USA

STILLEHAVSLANDENE
Australien / New Zealand

ASIEN
Kina / Hong Kong / Indien / Indonesien / Korea 
/ Malaysia / Pakistan / Filippinerne / Singapore / 
Taiwan / Thailand / Vietnam

AFRIKA
Sydafrika

MELLEMØSTEN
Forenede Arabiske Emirater

Din Philips F1rst Choice garanti

Tak fordi du valgte at købe denne Philips-skærm.

Alle Philips-skærme er konstrueret 
og fremstillet efter høje standarder 
og giver funktion i høj kvalitet, 
brugervenlighed og nem installation. 
Hvis du støder på vanskeligheder 

under installation eller anvendelse af dette produkt, 
bedes du kontakte Philips hjælpecenter direkte for 
at få glæde af din Philips F1rst Choice garanti. Med 
denne toårige garanti er byttemodel du berettiget 
til byttemodel leveret på adressen, hvis skærmen 
viser sig at være behæftet med mangler eller fejl. 
Philips tilstræber en udskiftning inden for 48 timer 
efter dit opkald..

Hvad er dækket?
Philips F1rst Choice Warranty gælder i Andorra, 
Østrig, Belgien, Cypern, Danmark, Frankrig, Tyskland, 
Grækenland, Finland, Irland, Italien, Liechtenstein, 
Luxemburg, Monaco, Nederlandende, Norge, 
Polen, Portugal, Sverige, Schweiz, Spanien og 
Storbritannien og kun for skærme, der er 
oprindeligt konstrueret, fremstillet, godkendt og/
eller autoriseret til brug i disse lande.

Garantidækningen begynder fra den dag hvor 
købte din monitor. I to år derefter, byttes skærmen 
til en skærm i mindst tilsvarende model i tilfælde af 
defekter, der er omfattet af garantien.

Ombytningsskærmen vil være din ejendom, og 
Philips beholder den defekte/oprindelige skærm. 
For ombytningsskærmen gælder den samme 
garantiperiode som for den oprindelige skærm, 
nemlig 24 måneder fra købsdatoen for den 
oprindelige skærm.
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Hvad er undtaget?
Philips F1rst Choice garanti dækker under 
forudsætning af, at produktet behandles 
korrekt og anvendes til det tilsigtede formål i 
overensstemmelse med dens betjeningsvejledning, 
og ved forevisning af den originale faktura 
eller kvittering med angivelse af købsdatoen, 
forhandlerens navn samt model og 
produktionsnummer for produktet.

Philips F1rst Choice garanti gælder eventuelt ikke, 
hvis:

Dokumenterne er ændret eller på nogen 
måde er gjort ulæselige. 
Modellen eller produktionsnummeret på 
produktet er ændret, slettet, fjernet eller gjort 
ulæseligt. 
Reparationer eller produktændringer er udført 
af uautoriserede serviceorganisationer eller 
personer. 
Skade er opstået som følge af uheld, herunder 
men ikke begrænset til lynnedslag, vand eller 
ild, misbrug eller forsømmelighed. 
Modtageproblemer forårsaget af signalforhold, 
kabel eller antennesystemer udenfor 
produktet; 
Defekter, der er forårsaget af misbrug af 
monitoren;
Produkter der kræver modifikation eller 
tilpasning for, at de kan opfylde de lokale eller 
nationale tekniske standarder, som gælder i 
lande, for hvilket produktet ikke oprindeligt 
var designet, fremstillet, godkendt og/eller 
autoriseret. Derfor skal du altid kontrollere om 
et produkt kan bruges i et specifikt land.
Bemærk, at Philips F1rst Choice garantien 
ikke dækker produkter, der ikke oprindeligt 
er konstrueret, fremstillet godkendt og/eller 
autoriseret til brug i Philips F1rst Choice-
lande. I sådanne tilfælde gælder Philips 
verdensomspændende garanti. 

Kun et klik væk
I tilfælde af problemer, anbefaler vi at du læser 
instruktionsvejledningen grundigt, eller går ind på 
www.philips.com/support website for yderligere 
support.

Kun en telefonopringning borte
For at undgå unødig ulejlighed, tilråder vi at 
læse betjeningsvejledningen omhyggeligt eller få 
yderligere hjælp ved at gå til Web-stedet www.
philips.com/support, før du kontakter Philips 
hjælpecenter.

For at få problemet løst hurtigst og nemt, bedes 
du have følgende oplysninger klar, før du kontakter 
Philips hjælpecenteret:

Philips typenummer
Philips serienummer
Købsdato (kopi af købsbevis kan være 
påkrævet)
PC processor:
o CUP og grafikkortsnavn og driverversion 
o Operativsystem 
o Program bruges 

Andre installerede kort

Hvis følgende oplysninger er til rådighed, vil det 
også befordre sagen:

Købsbevis med angivelse af: 
Købsdato, forhandlernavn, model og 
produktserienummer.
Den fuldstændige adresse, hvor den 
fejlbehæftede skærm skal afhentes, og 
ombytningsmodellen skal leveres.

Philips-kundeservice findes over hele verden.  Klik 
her for at få adgang til Lite kontaktoplysninger.

Eller du kan nå os via:Web-sted:
Websted: http://www.philips.com/support
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F1rst Choice kontaktoplysningerne

Land Kode Telefonnummer Takst
Østrig +43 0810 000206 €0,07
Belgien +32 078 250851 €0,06
Danmark +45 3525 8761 Lokal opkaldstakst
Finland +358 840 320 041 €0,08
Luxembourg +352 26 84 30 00 Lokal opkaldstakst
Holland +31 0900 0400 063 €0,10
Norge +47 2270 8250 Lokal opkaldstakst
Polen +48 0223491505 Lokal opkaldstakst
Portugal +351 2 1359 1440 Lokal opkaldstakst
Spanien +34 902 888 785 €0,10
Sverige +46 08 632 0016 Lokal opkaldstakst
Schweiz +41 02 2310 2116 Lokal opkaldstakst
Storbritannien +44 0207 949 0069 Lokal opkaldstakst
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International garanti

Kære kunde 
Tak, fordi du købte dette Philips produkt, der 
er konstrueret og fremstillet efter højeste 
kvalitetsstandarder. Hvis noget alligevel skulle 
gå galt, med dette produkt, garanterer Philips 
gratis arbejdsløn og reservedele, reparationen 
er foretaget, i en periode på 24 måneder fra 
købsdatoen. 

Hvad er dækket?
Denne garanti fra Philips i Central- og Østeuropa, 
gælder i Tjekkiet, Ungarn, Slovakiet, Slovenien, 
Rusland og Tyrkiet og kun for monitorer der 
oprindelig er designet, fremstillet, godkendt og/
eller autoriseret til brug i disse lande.. 

Garantidækningen begynder fra den dag hvor du 
købte din monitor. I 2 år derefter, vil din monitor 
blive repareret i tilfælde af defekter, der er dækket 
af garantien.

Hvad er undtaget? 
Philips garanti dækker under forudsætning af, at 
produktet behandles korrekt og anvendes til det 
tilsigtede formål i overensstemmelse med dens 
betjeningsvejledning, og ved forevisning af den 
originale faktura eller kvittering med angivelse af 
købsdatoen, forhandlerens navn samt model og 
produktionsnummer for produktet. 

Philips garanti gælder eventuelt ikke, hvis:
Dokumenterne er ændret eller på nogen 
måde er gjort ulæselige. 
Modellen eller produktionsnummeret på 
produktet er ændret, slettet, fjernet eller gjort 
ulæseligt. 
Reparationer eller produktændringer er udført 
af uautoriserede serviceorganisationer eller 
personer. 
Skade er opstået som følge af uheld, herunder 
men ikke begrænset til lyn, vand eller ild, 
misbrug eller forsømmelighed. 

Modtageproblemer forårsaget af signalforhold, 
kabel eller antennesystemer udenfor 
produktet; 
Defekter, der er forårsaget af misbrug af 
monitoren; 
Produkter der kræver modifikation eller 
tilpasning for, at de kan opfylde de lokale eller 
nationale tekniske standarder, som gælder i 
lande, for hvilket produktet ikke oprindeligt 
var designet, fremstillet, godkendt og/eller 
autoriseret. Derfor skal du altid kontrollere om 
et produkt kan bruges i et specifikt land.

Bemærk, at produktet ikke er defekt under denne 
garanti i tilfælde, hvor ændringer er påkrævet, for 
at produktet kan overholde lokale eller nationale 
tekniske standarder, der gælder i lande, hvortil 
produktet ikke oprindeligt er konstrueret og/eller 
fremstillet. Derfor skal du altid kontrollere om et 
produkt kan bruges i et specifikt land.

Kun et klik væk
I tilfælde af problemer, anbefaler vi at du læser 
instruktionsvejledningen grundigt, eller går ind på 
www.philips.com/support website for yderligere 
support. 

Kun en telefonopringning borte 
For at undgå unødig ulejlighed, tilråder vi, at 
du læser betjeningsvejledningen omhyggeligt, 
før du kontakter vore forhandlere eller 
informationscenter. 

I tilfælde af at dit Philips produkt ikke virker 
korrekt, eller er defekt, kontakt venligst din 
Philips forhandler eller kontakt Philips Service og 
Consumer Center direkte.

Websted: http://www.philips.com/support
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Forbruger Informationscentre

Argentina / Australien / Brasilien / Canada / New 
Zealand / Hviderusland / Bulgarien / Kroatien / 
Tjekkiet / Estland / Forenede Arabiske Emirater / 
Hong Kong / Ungarn / Indien / Indonesien / Israel 
/ Letland / Litauen / Malaysia / Mellemøsten + 
Nordafrika / New Zealand / Pakistan / Rumænien 
/ Rusland / Serbien & Montenegro / Singapore 
/ Slovakiet / Slovenien / Sydafrika / Sydkorea / 
Taiwan / Filippinerne / Thailand / Tyrkiet / Ukraine / 
Vietnam

ØSTEUROPA
BELARUS Technic al Center of JV IBA 
M. Bogdanovich str. 155 
BY - 220040 Minsk 
Tel: +375 17 217 33 86

HVIDERUSLAND 
Service.BY
Petrus Brovky st. 19 – 101-B
220072, Minsk
Hviderusland

BULGARIEN
LAN Service
140, Mimi Balkanska Str.
Office center Translog
1540 Sofia, Bulgarien
Tel: +359 2 960 2360
www.lan-service.bg

TJEKKIET
General Consumer Information Center 
800 142100

Xpectrum
Lu.ná 591/4
CZ - 160 00 Praha 6 Tlf.: 800 100 697 or 220 121 
435
E-mail:info@xpectrum.cz
www.xpectrum.cz

KROATIEN
Renoprom d.o.o.
Ljubljanska 4,
Sv. Nedjelja,10431
Kroatien
Tel: +385 1 333 0974

ESTLAND
FUJITSU SERVICES OU
Akadeemia tee 21G
EE-12618 Tallinn
Tel: +372 6519900
www.ee.invia.fujitsu.com

UNGARN
Serware Szerviz
Vizimolnár u. 2-4
HU - 1031 Budapest 
Tel: +36 1 2426331
E-mail: inbox@serware.hu
www.serware.hu

UNGARN
Profi Service Center Ltd.
123 Kulso-Vaci Street,
H-1044 Budapest (Europæisk center)
UNGARN
Tel: +36 1 814 8080 
E-mail: m.andras@psc.hu

LETLAND
ServiceNet LV
Jelgavas iela 36
LV - 1055 Riga,
Tel: +371 7460399
E-mail: serviss@servicenet.lv

LITAUEN
ServiceNet LT
Gaiziunu G. 3
LT - 3009 KAUNAS
Tel: +370 7400088
E-mail: servisas@servicenet.lt
www.servicenet.lt    
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RUMÆNIEN
Blue Ridge Int'l Computers SRL
115, Mihai Eminescu St., Sector 2
RO - 020074 Bucharest
Tel: +40 21 2101969

SERBIEN & MONTENEGRO
Kim Tec d.o.o.
Viline vode bb, Slobodna zona 
Beograd L12/3
11000 Belgrade
Serbien
Tel: +381 11 20 70 684

SLOVAKIET
General Consumer Information Center 
0800004551

Datalan Servisne Stredisko
Puchovska 8
SK - 831 06 Bratislava 
Tel: +421 2 49207155
E-mail: servis@datalan.sk

SLOVENIEN
PC HAND 
Brezovce 10 
SI - 1236 Trzin 
Tel: +386 1 530 08 24
E-mail: servis@pchand.si 

RUSLAND
CPS
18, Shelepihinskaya nab. 
123290 Moscow 
Rusland
Tel: +7(495)797 3434

Profservice: 
14A -3, 2Karacharovskaya str, 
109202, Moscow , 
Rusland
Tel: +7(095)170-5401

TYRKIET
Türk Philips Ticaret A.S.
Yukari Dudullu Org.San.Bolgesi
2.Cadde No:22 
34776-Umraniye/Istanbul
Tel: (0800)-261 33 02

UKRAINE
Comel
Shevchenko street 32
UA - 49030 Dnepropetrovsk
Tel: +380 562320045
www.csp-comel.com LLC Topaz Company 
Topaz-Service Company, 
Mishina str. 3, 
Kiev
Ukraine-03151
Tel: +38 044 245 73 31

LATINAMERIKA
ARGENTINA
Azopardo 1480.
(C1107ADZ) Cdad. de Buenos Aires
Tel: 0800 3330 856
E-mail: CIC.monitores@Philips.com

BRASILIEN
Alameda Raja Gabaglia, 188 - 10°Andar - V. 
Olímpia - S. Paulo/SP - CEP 04551-090 - 
Brasilien
Tel: 0800-7254101 
E-mail: CIC.monitores@Philips.com

Stillehavsområdet
AUSTRALIEN
Firma: AGOS NETWORK PTY LTD
Adresse:  4/5 Dursley Road, Yenorra, NSW 2161, 
Australien
Tel: 1300 360 386
Fax : +61-2-80808147
E-mail: philips@agos.com.au
Åbningstider: Man. til fred. 8:00 -19:30pm
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NEW ZEALAND
Firma:  Visual Group Ltd.  
Adresse:  28 Walls Rd Penrose Auckland
Tel:  0800 657447
Fax :  09 5809607
E-mail:  vai.ravindran@visualgroup.co.nz
Åbningstider: Man. til fred. 8:30 til 17:30pm

Asien
HONG KONG/Macau
Firmanavn: PHK Service Limited
Adresse: Flat A, 10/F., Pak Sun Building, 103 - 107 
Wo Yi Hop Road, Kwai Chung, New  Territories, 
Hong Kong
Tel: (852) 2610-6908 / (852) 2610-6929 for Hong 
Kong og (853) 2856-2277 for Macau
Fax : (852) 2485 3574 for Hong Kong og (853) 
2856 1498 for Macau
E-mail: enquiry@phkservice.com.hk
Åbningstider: Man. til lør. 9:00 til 18:00pm

Indien
Firma: REDINGTON INDIA LTD
Adresse: SPL Guindy House, 95 Mount Road, 
Chennai 600032, Indien
Tel: +9144-42243352/353
E-mail: aftersales@in.aocmonitor.com
Åbningstider: Man. til fred. 9:00 til 17:30PM; Lør. 
9:00 til 13:00pm

Indonesien
Firmanavn: PT. Gadingsari elektronika Prima
Adresse: Komplek Pinang 8, Jl. Ciputat raya No. 8F, 
Pondok Pinang. Jakarta 
Tel: 021-750909053, 021-750909056 
Fax : 021-7510982 
E-mail: gepta@cbn.net.id  
Åbningstider: Man. til fred. 8:30 til 16:30pm; 
Lør. 8:30 til 14:00pm

Yderligere servicesteder: 

1. Philips Building Jl. Buncit Raya Kav 99. Jakarta 
Selatan. 

  Tel: 021-7940040, lokal 1722/1724, 98249295, 
70980942

2. Jl. Tanah Abang 1 no 12S. Jakarta Pusat. 

  Tel: 021-3455150, 34835453 

3. Rukan City Home no H31, Gading Square. Jl. 
Bulevar Barat. Kelapa Gading. Jakarta Utara. Tel: 
021-45870601, 98131424

Sydkorea 
Firma: PCS One Korea Ltd. 
Adresse: 112-2, Banpo-dong, Seocho-ku, Seoul, 
137-040, Korea  
Call Center Tel: 080-600-6600 
Tel: 82 2 591 1528 
Fax : 82 2 595 9688 
E-mail: cic_korea@philips.com  
Åbningstider: Man. til fred. 9:00 til 18:00pm; Lør. 
9:00 til 13:00pm

Malaysia
Firma: After Market Solutions (CE) Sdn Bhd 
Adresse: Lot 6. Jalan 225/51A, 46100 Petaling Jaya, 
Selangor DE, Malaysia. 
Tel: 603 7953 3370 
Philips Info Line: 1-800-880-180 
Fax : 603 7953 3338 
E-mail: pceinfo.my@philips.com  
Åbningstider: Man. til fred. 8:15 til 17:15pm; Lør. 
9:00 til 13:00pm

Pakistan
Philips Consumer Service
Adresse: Mubarak manzil, 39, Garden Road, Saddar, 
Karachi-74400
Tel: (9221) 2737411-16
Fax : (9221) 2721167
E-mail: care@philips.com
Websted: www.philips.com.p
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Singapore 
Firma: Philips Electronics Singapore Pte Ltd (Philips 
Consumer Care Center)
Adresse: 620A Lorong 1 Toa Payoh, TP4 Building 
Level 1, Singapore 319762
Tel: (65) 6882 3999
Fax : (65) 62508037
E-mail: consumer.care.sg@philips.com
Åbningstider: Man. til fred. 9:00 til 18:00pm; Lør. 
9:00 til 13:00pm

Taiwan
Firma: FETEC.CO 
Adresse: 3F, No.6, Lane 205, Sec. 1, Chang Hsing 
Rd, Lu Chu Hs, Taoyuan, Taiwan R.O.C  33800  
Kundepleje: 0800-231-099 
Tel: (03)2120336 
Fax : (03)3129184 
E-mail: knlin08@xuite.net  
Åbningstider: Man. til fred. 8:30 til 21:00pm

Thailand
Firma: Axis Computer System Co., Ltd.
Adresse: 1421 Soi Lardprao 94, Srivara Town In 
Town Soi 3 Road, Wangthonglang, Bangkok 10310 
Thailand
Tel: (662) 934-5498
Fax : (662) 934-5499 
E-mail: axis5@axiscomputer.co.th
Åbningstider: Man. til fred. 8:30 til 17:30pm

Glee Electronics Inc
Kontakt tlf. (632) 636-3636 / 7064028 til 29
Fax nr. (632) 7064026 

Modtagende centre
NEO CARE - Megamall
4th Level Cyberzone, Building B,
SM Megamall, Mandaluyong City

NEO CARE - SM North EDSA
4th Level Cyberzone, Annex Bldg.
SM City North EDSA, Quezon City
441-1610

MDR Microware Sales Inc.
Cebu Branch
N. Escario corner Clavano St., Cebu City Phils.
Tel:  255-4415/ 255-3242/253-9361/4124864 til 
67
Søn. tlf. 0922-8210045 til 46

Davao Office:
C. Arellano St., Davao City 8000
082- 225-3021/225-3022
Søn. tlf. 0922-8210015  

CDO Office:
1445 Corrales Ext.,CDO City
088-856-8540/856-8541
Søn. tlf. 0922-8210080

Iloilo Office:
C. Lim Comp., Gomez St., Iloilo City
# 033 338-4159/ 033 508-3741
Søn. tlf. 0922-8808850 

Afrika
SYDAFRIKA
Firmanavn: Sylvara Technologies Pty Ltd
Adresse: Ho Address Palm Springs Centre 
Christoffel Road Van Riebeeck Park Kempton Park,  
Sydafrika
Tel: +27878084456 
Fax : +2711 391 1060
E-mail: customercare@philipssupport.co.za
Åbningstider: Man. til fre. 8:00 til 17:00pm

Mellemøsten
Mellemøsten + Nordafrika
Firma: AL SHAHD COMPUTER L.L.C 
Adresse: P. O. BOX: 29024, DUBAI, UNITED 
ARAB EMIRATES  
Tel: 00971 4 2276525 
Fax: 00971 4 2276242 
E-mail: shahd52@eim.ae  
Åbningstider: Lør. til Tor. 9:00 til 13:00pm & 16:00 
til 20:00pm
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Din Philips F1rst Choice garanti(USA)

Tak fordi du valgte at købe denne Philips-skærm.

Alle Philips skærme er designet og 
produceret iht. høje standarder og 
leverer høj kvalitet, er nem at bruge og 
opsætte. Hvis der opstår problemer 
under opsætningen eller brugen af 

produktet, skal du kontakte Philips direkte for at 
kunne drage fordel af garantien Philips First Choice 
Warranty. Denne toårs servicegaranti giver dig 
ret til at ombytte modellen på opsætningsstedet 
indenfor 48 timer efter din opringning, inden 
for det første år fra købsdatoen. Hvis du har 
problemer med skærmen inden for det andet 
eller tredje år fra købsdatoen, vil vi gratis reparere 
den efter den er sendt til servicecentret - du skal 
selv betale forsendelsesomkostningerne. Skærmen 
returneres igen inden for fem arbejdsdage. 

BEGRÆNSET GARANTI (Computerskærm)

Klik her for at komme til  Warranty Registration 
Card.

To års gratis udførelse/To års gratis service på 
dele/Et års ombytningsret *

*Produktet ombyttes med et nyt, eller et produkt, 
der er rekonstrueret ifølge specifikationerne, 
indenfor to forretningsdage i det første år. Du 
skal selv betale for forsendelsen til service i toårs 
garantiperioden.

Israel
Firma: Eastronics LTD
Adresse: 13 Rozanis St. P.O.B. 39300, Tel  Aviv  
61392  Israel
Tel: 1-800-567000 gratisnummer i Israel; (972-50-
8353722 efter åbningstid indtil 20:00)
Fax : 972-3-6458759
E-mail: eastronics@eastronics.co.il
Åbningstider: Søn. til Tor. 08:00 - 18:00
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HVEM ER DÆKKET?
Du skal have et købsbevis for at kunne modtage 
service under garantien. En kvittering eller et andet 
dokument, der viser, at du har købt produktet, 
betragtes som et købsbevis. Hæft det på denne 
vejledning og hav begge dele i nærheden. 

HVAD DÆKKES?
Garantien starter på købsdatoen. I to år derefter 
vil alle dele blive repareret eller ombyttet. 
Udførelse er gratis. To år fra købsdatoen skal du 
betale for ombytning og reparation, for alle dele 
og for udførelse.

Alle dele, herunder reparerede og udskiftede 
dele, dækkes kun i den oprindelige garantiperiode. 
Når garantien udløber på det originale produkt, 
udløber også garantien på alle udskiftede og 
reparerede produkter og dele. 

HVAD ER UDELUKKET?
Garantien dækker ikke: 
Arbejdsløn for installation eller opsætning 
af produktet, justering af brugerdefinerede 
kontrolelementer på produktet, og installation eller 
reparation af antennesystemer uden for produktet. 

Produktreparation og/eller udskiftning af dele som 
følge af misbrug, uheld, uautoriseret reparation 
eller af anden grund, der er uden for Philips 
Consumer Electronics indflydelse. 

Modtageproblemer forårsaget af signalforhold, 
kabel eller antennesystemer udenfor produktet; 

Et produkt, der kræver ændringer eller tilpasninger 

for at gøre det i stand til at fungere i et andet land 
end det, til hvilket det er konstrueret, fremstillet, 
godkendt og/eller autoriseret, eller reparation af 
produkter, der er skadet af disse modifikationer.

Opståede skader eller følgeskader forårsaget af 
produktet. (Visse stater tillader ikke udelukkelse 
af opståede skader eller følgeskader, hvorfor 
ovenstående udelukkelse eventuelt ikke gælder for 
dig. Dette omfatter, men begrænses ikke til optaget 
materiale, uanset, om det er med copyright eller 
ej.)

Modellen eller produktionsnummeret på 
produktet er ændret, slettet, fjernet eller gjort 
ulæseligt.  

Hvor ER DER SERVICE TIL RÅDIGHED?
Service under garantien er til rådighed i alle 
lande, hvor produktet officielt distribueres af 
Philips Consumer Electronics. I lande, hvor Philips 
Consumer Electronics ikke distribuerer produktet, 
vil den lokale Philips serviceorganisation tilstræbe 
at give service (skønt der kan opstå forsinkelse, 
hvis de korrekte reservedele og tekniske 
håndbøger ikke er umiddelbart til rådighed). 

Hvor FÅR JEG FLERE OPLYSNINGER?

Du kan få flere oplysninger ved at kontakte Philips 
Customer Care Center ved at ringe på (877) 835-
1838 (Kun for kunder i USA) eller (919) 573-
7855. 

Inden du anmoder om service...
Se i vejledningen, før du rekvirerer service. 
Justering af de kontrolelementer, der omtales her, 
kan spare dig for en opringning efter service. 
YDELSE AF GARANTISERVICE I USA., PUERTO 
RICO ELLER DE AMERIKANSKE JOMFRUØER...

Kontakt Philips kundeoplysningscenter på 



40

nedenstående telefonnummer for at få 
produktassistance og fremgangsmåder ved ydelse 
af service: 

Philips kundeservicecenter 
(877) 835-1838 eller (919) 573-7855 

(I USA., Puerto Rico og de amerikanske jomfruøer 
er varigheden af alle antydede garantier, herunder 
garantier om salgbarhed og egnethed til et 
bestemt formål begrænset til varigheden af denne 
udtrykkelige garanti. Da visse stater dog ikke 
tillader begrænsninger , for, hvor længe en antydet 
garanti må vare, gælder denne begrænsning 
eventuelt ikke i det aktuelle tilfælde.)

YDELSE AF GARANTISERVICE I KANADA...

Kontakt Philips på: 
(800) 479-6696 

Philips Canada, eller et af dets autoriserede 
servicecentre, leverer to års gratis dele og to års 
gratis udførelse. 

(I Kanada gives denne garanti i stedet for alle 
andre garantier. Der udtrykkes eller antydes 
ikke andre garantier, herunder garantier om 
salgbarhed eller egnethed til et bestemt formål. 
Philips hæfter under ingen omstændigheder for 
nogen direkte, indirekte, specielle, opståede skade 
eller følgeskader, uanset hvordan den er pådraget, 
heller ikke hvis der er underrettet om risikoen for 
sådanne skader.) 
HUSK...Noter model- og serienumre på produktet 
nedenfor. 

Model- # _____________________________

Serienumre # __________________________
Denne garanti giver dig visse juridiske rettigheder. 
Du kan have andre rettigheder, afhængigt af den 
pågældende stat/provins.

Før du kontakter Philips, skal du have følgende 

oplysninger parat, så vi hurtigt kan løse dit 
problem. 

Philips typenummer
Philips serienummer 
Købsdato (kopi af købsbevis kan være 
påkrævet) 
PC processor:
o CUP og grafikkortsnavn og driverversion 
o Operativsystem 
o Program bruges

Andre installerede kort
Hvis følgende oplysninger er til rådighed, vil 
det også befordre sagen: 
Købsbevis med angivelse af: 
Købsdato, forhandlernavn, model og 
produktserienummer. 
Den fulde adresse, hvortil ombytningsmodellen 
skal leveres.

Kun en telefonopringning borte
Philips-kundeservice findes over hele verden. I 
Amerika kan du kontakte Philips-kundeservice 
mandag-fredag fra 8:00 AM-9:00 PM Eastern Time 
(ET) og lørdage fra 10:00 AM-5:00 PM (ET) ved 
hjælp af et af kontakt-telefonnumrene.

For flere oplysninger om dette og om flere 
fremragende Philips-produkter, så besøg vores 
hjemmeside på:

Websted: http://www.philips.com
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Din internationale garanti
Kære kunde

Tak, fordi du købte dette Philips produkt, der 
er konstrueret og fremstillet efter højeste 
kvalitetsstandarder. 

Hvis noget alligevel skulle gå galt, med dette 
produkt, garanterer Philips gratis arbejdsløn og 
reservedele, uanset i hvilket land, reparationen 
er foretaget, i en periode på 12 måneder 
fra købsdatoen. Denne internationale 
Philips garanti supplerer den eksisterende 
nationale garantiforpligtelse fra forhandlere 
og Philips i købslandet og påvirker ikke dine 
forfatningsmæssige rettigheder som kunde og 
forbruger.

Philips garanti dækker under forudsætning af, at 
produktet behandles korrekt og anvendes til det 
tilsigtede formål i overensstemmelse med dens 
betjeningsvejledning, og ved forevisning af den 
originale faktura eller kvittering med angivelse af 
købsdatoen, forhandlerens navn samt model og 
produktionsnummer for produktet.

Philips garanti gælder eventuelt ikke, hvis:
Dokumenterne er ændret eller på nogen 
måde er gjort ulæselige. 
Modellen eller produktionsnummeret på 
produktet er ændret, slettet, fjernet eller gjort 
ulæseligt. 
Reparationer eller produktændringer er udført 
af uautoriserede serviceorganisationer eller 
personer. 
Skade er opstået som følge af uheld, herunder 
men ikke begrænset til lyn, vand eller ild, 
misbrug eller forsømmelighed. 

Bemærk, at produktet ikke er defekt under denne 
garanti i tilfælde, hvor ændringer er påkrævet, for 
at produktet kan overholde lokale eller nationale 
tekniske standarder, der gælder i lande, hvortil 
produktet ikke oprindeligt er konstrueret og/eller 
fremstillet. Derfor skal du altid kontrollere om et 
produkt kan bruges i et specifikt land.

Hvis dit Philips produkt ikke fungerer korrekt eller 
er defekt, bedes du kontakte din Philips forhandler. 
Hvis du har behov for service under et ophold i et 
andet land, kan der opgives en forhandleradresse 
til dig af Philips kundeservice i det pågældende 
land, hvis telefon- og faxnummer kan findes i den 
relevant del af dette hæfte.

For at undgå unødig ulejlighed tilråder vi at 
læse betjeningsvejledningen omhyggeligt, før du 
kontakter din forhandler. Hvis du har spørgsmål, 
din forhandler ikke kan besvare, eller har andre 
relevante spørgsmål, bedes du kontakte Philips 
forbrugeroplysningscentre eller gå på:
Websted: http://www.philips.com
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7 Fejlfinding og FAQ

7.1 Fejlfinding

Denne side omhandler problemer, som kan klares 
af brugeren selv. Hvis problemet stadig er der, efter 
at du har prøvet disse løsninger, skal du kontakte 
Philips's Kundeservice.

Almindelige problemer

Intet billede (strømdiode lyser ikke)
Kontroller, at el-ledningen er anbragt i 
stikkontakten og bag på skærmen. 
Kontroller først, at strømkontakten foran på 
skærmen er i OFF (FRA) position og tryk den 
derefter i ON (TIL) position.

Intet billede (strømdiode blinker hvidt)
Kontroller, at der er tændt for computeren. 
Kontroller, at signalkablet er korrekt forbundet 
til computeren. 
kontroller, at der ikke er nogen bøjede stikben 
i signalkablets tilslutningsende. Hvis der er det, 
skal du få kablet repareret eller udskiftet. 
Energisparefunktionen kan være aktiveret

Skærm siger

Kontroller, at signalkablet er korrekt 
forbundet til computeren. (Se også quick-
installationsvejledningen). 
Tjek, om skærmkablets stikben er bøjede. 
Kontroller, at der er tændt for computeren. 

AUTO (AUTOM.)-knappen virker ikke

Den automatiske funktion fungerer kun i 
VGA analog-tilstand.  Hvis resultatet ikke er 
tilfredsstillende, kan der foretages manuelle 
justeringer via OSD-menuen.  

Bemærkning
  Den automatiske funktion er ikke nødvendig i 

DVI digital-tilstand. 

Synlige tegn på røg eller gnister
Forsøg ikke at fejlfinde
Træk straks skærmens stik ud af stikkontakten
Kontakt straks en repræsentant fra Philips 
kundeafdeling.

Billeddannelses-problemer

Billedet er ikke centreret
Justér billedets position med funktionen “Auto” 
(Automatisk) i OSD-menuerne. 
Juster billedpositionen med Phase/Clock (Fase/
Klokke) i OSD-menuernen.  Den kan kun 
bruges i VGA-tilstand. 

Billede vibrerer på skærmen
Tjek, at signalkablet er korrekt forbundet til 
grafikkortet eller pc'en. 

Lodret flimren

Justér billedet med funktionen “Auto” 
(Automatisk) i OSD-menuerne. 
Eliminer de lodrette bjælker med Phase/Clock 
(Fase/Klokke) i OSD-menuernen. Den kan kun 
bruges i VGA-tilstand.
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Vandret flimren

Justér billedet med funktionen “Auto” 
(Automatisk) i OSD-menuerne. 
Eliminer de lodrette bjælker med Phase/Clock 
(Fase/Klokke) i USD hovedmenuen. Den kan 
kun bruges i VGA-tilstand.

Billedet er sløret, uklart eller for mørkt
Indstil kontrast og lysstyrke i OSD.

Der forbliver et "efterbillede", 
"indbrændingsbillede" eller "spøgelsesbillede", 
efter at der er slukket for strømmen.

Uafbrudt visning af stille eller statiske billeder 
over en længere periode kan forårsage, 
at det “brændes fast” på skærmen, dvs. de 
såkaldte “spøgelsesbilleder” på din skærm. 
"Fastbrænding" og "spøgelsesbilleder" er 
velkendte fænomener inden for LCD-
skærmteknologien. I de fleste tilfælde 
forsvinder "indbrænding" eller "efterbillede" 
eller "spøgelsesbillede" gradvist, efter at 
strømmen er slået fra. 
Sørg altid for at aktivere en pauseskærm, der 
bevæger sig, når skærmen efterlades uden at 
blive anvendt. 
Sørg altid for at aktivere et program, der 
opdaterer skærmbilledet regelmæssig, hvis 
LCD-skærmen viser indhold, der ikke skifter.
Imidlertid forsvinder alvorligere tilfælde af 
“fastbrænding” og “spøgelsesbilleder” ikke 
og kan ej heller fjernes ved reparation. 
Ovennævnte skader er ikke dækket af 
garantien.

Billedet er forvrænget. Tekst er utydelig eller 
sløret. 

Indstil pc'ens skærmopløsning som skærmens 
anbefalede, native opløsning. 

Der ses røde, blå, mørke og hvide pletter på 
skærmen

De resterende prikker er normale i den 
flydende krystal-teknik, der bruges i dag. Se 
politikken om pixels for yderligere oplysninger. 

"Tændt"-lyset er for kraftigt. Det forstyrrer 
Du kan justere “Tændt”-lyset med Strømdiode 
i OSD-menuerne.

For yderligere hjælp, se venligst Forbruger-
informationscentre-listen og kontakt Philips's 
Kundeservice.
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7.2 FAQ for SmartControl Lite

SP1. Jeg har udskiftet skærmen på en pc 
til en anden skærm, og nu fungerer 
SmartControl Lite ikke længere. Hvad skal 
jeg gøre?

Sv.: Genstart din pc og se, om SmartControl 
Lite fungerer nu. Eller skal du afinstallere og 
geninstallere SmartControl Lite for at sikre, 
at den korrekte driver er installeret.

SP2. SmartControl Lite fungerede fint tidligere, 
men nu virker programmet ikke længere. 
Hvad skal jeg gøre?

Sv.: Hvis nogle af de følgende handlinger har 
været udført, skal skærmdriveren måske 
geninstalleres.

Videografikadapter er blevet udskiftet med 
en anden 
Opdater videodriver 
Aktiviteter i OS som f.eks. servicepakke 
eller programrettelse 
Opdater Windows og opdater skærm- og/
eller videodriver 
Windows blev startet med skærmens 
strøm slået fra eller afbrudt.
For at finde ud af det, skal du klikke 
på "Denne Computer" og derefter på 
Egenskaber -> Hardware ->Enhedsstyrer. 
Hvis du ser "Plug & Play skærm" under 
Skærm, skal du geninstallere. Afinstallér 
SmartControl Lite og geninstallér det.

SP3. Efter installation af SmartControl Lite sker 
der ingenting, selv om jeg klikker på fanen 
SmartControl Lite og venter, eller der 
vises en fejlmeddelelse. Hvorfor?

Sv.: Det skyldes muligvis, at din grafiske adapter 
ikke er kompatibel med SmartControl Lite. 
Hvis grafikadapteren er en af ovennævnte 
mærker, skal du prøve at downloade den 
mest opdaterede grafikadapterdriver fra 
det pågældende firmas ? websted. Installer 
driveren. Afinstallér SmartControl Lite og 

geninstallér det igen.
Hvis det stadig ikke virker, er vi bange for, 
at grafikadapteren ikke understøttes. Gå til 
Philips websted og kontrollér, om der findes 
en nyere driver for SmartControl Lite .

SP4. Når jeg klikker på "Product Information" 
("Produktinformation"), ses kun nogle af 
oplysningerne. Hvad er der sket?

Sv.: Det kan være, at din grafikkortadapterdriver 
ikke er den mest opdaterede version, som 
fuldt ud understøtter DCC/CI grænseflade. 
Prøv at downloade den mest opdaterede 
grafikkortadapterdriver fra det pågældende 
firmas ? websted. Installer driveren. Afinstallér 
SmartControl Lite og geninstallér det igen.

SP5. Jeg har glemt min PIN-kode til 
tyverisikringsfunktionen. Hvad skal jeg 
gøre?

Sv.: Philips servicecenter forbeholder sig retten 
til at bede om legitimation og godkendelse 
for at kunne etablere skærmens ejer.

        Bemærk venligst, at tyverisikringsfunktionen 
leveres som en ekstra mulighed. 
Administrationen af PIN-koder er 
den enkelte brugers eller indstillende 
organisations ansvar.

        Hvis du har glemt PIN-koden, kan Philips’ 
servicecenter efter bekræftelse af ejerskab 
genindstille den for dig mod betaling af et 
gebyr. Bemærk venligst, at denne aktivitet 
ikke er dækket af standardgarantien.
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7.3 Generelle FAQ

SP1: SP1:Hvad skal jeg gøre, hvis skærmen 
under installationen viser "Cannot display 
this video mode" ("Kan ikke vise denne 
videotilstand')?

Sv.: Den anbefalede opløsning for Philips 20" er : 
1600x900@60Hz.

Frakobl alle kabler og forbind derefter 
pc'en til skærmen, som du brugte før. 
I Windows Start Menu, vælg Indstillinger/
Kontrolpanel. I Kontrolpanel vinduet vælg 
Skærm-ikonen. I Egenskaber for Skærm 
vinduet vælg "Indstillinger" fanebladet. 
Under indstillinger, skub skyderen til 
1600x900 pixler (20"). 
Åbn "Avanceret" og indstil 
opdateringshastigheden på 60Hz og klik 
derefter på OK. 
Genstart computeren og gentag trinene 2 
og 3 for at bekræfte, at pc'en er indstillet 
på 1600x900@60Hz (20"). 
Luk for computeren, frakobl den gamle 
skærm og genforbind Philips LCD 
skærmen. 
Tænd for skærmen og derefter for pc'en.

SP2: Hvad gør den anbefalede 
opdateringshastighed for LCD skærmen?

Sv.: Den anbefalede opdateringshastighed 
for LCD skærme er 60Hz. I tilfælde af  
forstyrrelser på skærmen skal du sætte 
den op til 75Hz og se, om dette fjerner 
forstyrrelserne. 

SP3: Hvad er .inf og .icm filerne på cd-rom'en? 
Hvordan installerer jeg driverne (.inf og 
.icm)?

Sv.: Dette er skærmens driverfiler. Installer 
driverne i henhold til brugervejledningens 
anvisninger. Computeren kan bede dig om 
skærmdrivere (.inf og .icm filer) eller om en 
driverdisk, når du installerer skærmen første 
gang. Indsæt (medfølgende cd-rom) i pakken 
i henhold til anvisningerne. Skærmdrivere (.inf 
og .icm filer) installeres automatisk.

SP4: Hvordan justerer jeg opløsningen?

Sv.: Skærmkortet/grafikdriveren og skærmen 
bestemmer sammen opløsningerne til 
rådighed. Du kan vælge den ønskede 
opløsning "Egenskaber for Skærm" i 
Windows® kontrolpanelet.

SP5: Hvad, hvis jeg "farer vild", mens jeg justerer 
skærmen?

Sv.: Så skal du blot trykke på OK og derefter 
vælge "Reset" ("Tilbagestil") for at gå tilbage 
til de oprindelige fabriksindstillinger.

SP6: Er LCD-skærmen modstandsdygtig overfor 
ridser?

Sv.: Det anbefales generelt ikke at udsætte 
skærmens overflade for kraftige stød. Den 
er beskyttet mod skarpe og  stumpe ting. 
Når du håndterer skærmen så pas på ikke 
at trykke for kraftigt på skærmens overflade.  
Det kan påvirke garantibetingelserne.

SP7: SP7:Hvordan rengør jeg LCD skærmens 
overflade?

Sv.: Til normal rengøring skal du blot anvende 
en ren, blød klud. Til kraftigere rengøring skal 
du bruge isopropylalkohol. Brug ikke andre 
opløsningsmidler såsom ethylalkohol, ethanol, 
acetone, hexan osv.
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SP8: Kan jeg ændre skærmens farveindstilling?

Sv.: Ja, du kan ændre farveindstillingen via OSD 
på følgende måde:

Tryk på "OK" for at vise OSD (On Screen 
Display)-menuen
Tryk på "Ned-pil" for at vælge indstillingen 
"Color" (Farve), og tryk derefter på "OK" 
for at angive farveindstillingen. Der er tre 
indstillinger, som vist nedenfor.

1. Color Temperature (Farvetemperatur) 
- de seks indstillinger er 5000K, 6500K, 
7500K, 8200K, 9300K og 11500K. Med 
indstillinger i 5.000K området virker 
skærmen "varm" med en rød-hvid 
farvetone, mens en 11.500K temperatur 
giver en "kold" blå-hvid toning. 

2. sRGB - dette er en standardindstilling, 
som sikrer korrekt udveksling af farver 
mellem forskellige enheder (f.eks. digitale 
kameraer, skærme printere, skannere 
osv.) 

3. Brugerdefiner - brugeren kan vælge sin 
foretrukne farveindstilling ved at indstille 
den røde, grønne og blå farve.

Bemærk:
  Et mål for farven på lys, der udstråles fra 

et objekt, mens det opvarmes. Dette mål 
udtrykkes på en absolut skala (kelvingrader). 
Lavere kelvingrader såsom 2.004K er røde, 
højere temperaturer såsom 9.300K er blå. 
Neutral temperatur, 6.504K, er hvid.

SP9: Kan jeg forbinde min LCD skærm til 
enhver pc, arbejdsstation eller Mac?

Sv.: Ja. Alle Philips LCD skærme er fuldt 
kompatible med standard pc'er, Mac'er og 
arbejdsstationer. En ledningsadapter kan være 
nødvendig for at kunne forbinde skærmen til 
dit Mac-system. Vi anbefaler, at du kontakter 
Philips salgsrepræsentant for yderligere 
oplysninger. 

SP10: Er Philips LCD skærme "Plug & Play"?

Sv.: Ja, skærmene er "Plug & Play" kompatible 
med Windows 7, Vista, XP, NT, Mac OSX og 
Linux.

SP11: SP12:Hvilken slags bredvinkel-teknologi er 
til rådighed? 

Sv.: For indeværende har paneler af typen IPS 
det bedste kontrastforhold, sammenlignet 
med MVA- og PV-teknologierne.  TN-panelet 
er blevet forbedret gennem årene men 
IPS-paneler giver bedre resultater end TN-
paneler.

SP12: Hvad er "billedklæbning" eller 
"billedindbrænding" eller "efterbillede" 
eller "spøgelsesbillede" på LCD skærme?

Sv.: Uafbrudt visning af stille eller statiske billeder 
over en længere periode kan forårsage, 
at det “brændes fast” på skærmen, dvs. de 
såkaldte “spøgelsesbilleder” på din skærm. 
"Fastbrænding" og "spøgelsesbilleder" er 
velkendte fænomener inden for LCD-
skærmteknologien. I de fleste tilfælde 
forsvinder "indbrænding" eller "efterbillede" 
eller "spøgelsesbillede" gradvist, efter at 
strømmen er slået fra.
Sørg altid for at aktivere en pauseskærm, der 
bevæger sig, når skærmen efterlades uden at 
blive anvendt.
Sørg altid for at aktivere et program, der 
opdaterer skærmbilledet regelmæssig, hvis 
LCD-skærmen viser indhold, der ikke skifter.

Advarsel
  Alvorlig "indbrænding"- eller "efterbillede"- eller 

"spøgelsesbillede"-symptomer forsvinder ikke 
og kan ikke repareres. Ovennævnte skader er 
ikke dækket af garantien.
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SP13: Hvorfor viser skærmen ikke skarp tekst? 
Hvorfor viser den forrevne tegn?

Sv.: LCD skærmen arbejder bedst med sin native 
opløsning på 1600x900@60Hz. Brug denne 
opløsning for at opnå det bedste billede.
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